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Chapter 1. Introduction

The installation instructions guide you in installing, updating, and uninstalling
Rational® Programming Patterns V9.0.1.

Rational Programming Patterns is a set of development tools that are built on the
Eclipse platform (www.eclipse.org). You can think of the Eclipse platform as the
framework and Rational Programming Patterns and other bundled offerings as the
tool contributors.

Rational Programming Patterns is installed on the IBM® Rational Software Delivery
Platform. This platform is a common development environment that contains the
development workbench and other software components that are shared by
multiple products.

Rational Programming Patterns is constituted of the following two components:

* A client integrated with different products, depending on your environment:
Rational Developer for System z® V9.0 or Rational Developer for AIX® and _
Linux V9.0. The client is also always integrated with Rational Team Concert
V4.0.3.

* A server integrated with Jazz" Team Server V4.0.3.

Note: All the other versions of these products that are available when this version
of Rational Programming Patterns is released are also compatible.

You can install the Rational Programming Patterns V9.0.1 by updating the V9.0 or
V9.0.0.1 version. You can also carry out a full installation of the new version.
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Chapter 2. Rational Programming Patterns installation
requirements

VisualAge Pacbase installation requirements

To migrate the data that is stored in VisualAge® Pacbase databases, you must
verify that the workstation on which VisualAge Pacbase 3.5 Y09B will be installed
meets the installation requirements.

The installation requirements for the VisualAge Pacbase part are indicated in the
VisualAge Pacbase installation guide specific to your platform, in chapter
“Prerequisites”.

The VisualAge Pacbase installation guides are shipped with the VisualAge Pacbase
product. They are also available on the [VisualAge Pacbase documentation site]
(section The administrator's documentation).

Rational Programming Patterns client installation requirements

Installation requirements for a System z environment

To install the Rational Programming Patterns client in a System z environment, you
must verify that your workstation meets the minimum hardware and software
requirements for installing the client environment: Rational Developer for System z
V9.0, Rational Team Concert V4.0.3, and Rational Programming Patterns V9.0.1.

Note: All the other versions of these products that are available when this version
of Rational Programming Patterns is released are also compatible.

Verify the prerequisites of each product from the search interface of the
lsystem requirements] In this interface, enter the product name and click the search
icon. Select the relevant product in the search results and select the values of the
required fields. Then, submit the search.

Installation requirements for a System p environment

To install the Rational Programming Patterns client in a System p® environment,
you must verify that your workstation meets the minimum hardware and software
requirements for installing the client environment: Rational Developer for AIX and
Linux V9.0, Rational Team Concert V4.0.3, and Rational Programming Patterns
V9.0.1.

Note: All the other versions of these products that are available when this version
of Rational Programming Patterns is released are also compatible.

Verify the prerequisites of each product from the search interface of the [Detailed|
system requirements| In this interface, enter the product name and click the search
icon. Select the relevant product in the search results and select the values of the
required fields. Then, submit the search.
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Installation requirements for the Rational Programming Patterns server

To install the Rational Programming Patterns server, you must verify that your
workstation meets the minimum hardware and software requirements for installing
Jazz Team Server V4.0.3 and the Rational Programming Patterns server V9.0.1. To
use Rational Developer for System z specific functions, you can optionally install
the Rational Developer for System z server.

Note: All the other versions of these products that are available when this version
of Rational Programming Patterns is released are also compatible.

Verify the prerequisites of each product from the search interface of the
lsystem requirements| In this interface, enter the product name and click the search
icon. Select the relevant product in the search results and select the values of the
required fields. Then, submit the search.

User privileges requirements

4

You must have a user ID that meets the following requirements before you can
install Rational Programming Patterns:

* Your user ID must not contain double-byte characters.

* To install for all the users of the system, you must have an ID that belongs to
the Administrators group. If you do not have Administrator privileges, you can
install for the current user only.
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Chapter 3. Planning to install Rational Programming Patterns

Read this section before attempting to install any of the product features. Many
problems can be avoided by planning and understanding the key aspects of the
installation process before actually starting the installation.

IBM Installation Manager

IBM Installation Manager is a program that helps you install the Rational
Programming Patterns product package on your workstation. It also helps you
update, modify, and uninstall any package that you install. A package can be a
product, a group of components, or a single component that is designed for
Installation Manager to install.

IBM Installation Manager helps you keep track of what you have installed,
determine what is available for you to install, and organize installation directories.
It is installed on your system the first time you install a Rational Software Delivery
Platform product.

Installing products from their launchpad is recommended because it automatically
starts IBM Installation Manager. The necessary repository location information and
the packages to be installed are automatically preselected. Moreover if the IBM
Installation Manager version is not compatible with the version required to install
the new packages, its update is automatically proposed.

IBM Installation Manager includes wizards that make it easy to maintain packages
through their lifecycles:

* The Install wizard walks you through the installation process. You can install a
package by accepting the defaults, or you can change the default settings to
customize an installation. Before you install a package, you see a summary of
your selections throughout the wizard. Using the wizard, you can install one or
more packages at one time.

* The Update wizard searches for available updates to packages that you have
installed. An update can be a released fix, a new feature, or a new version of the
product. Details of the contents of the update are provided in the wizard. You
can decide whether to apply an update.

* With the Modify wizard, you can change certain elements of a package that you
have installed. During the first installation of the package, you select the features
to install. If you require other features later, you can use the Modify wizard to
add the features. You can also remove features.

* The Manage Licenses wizard helps you set up the licenses for your packages.
Use this wizard to change your trial license to a full license, to set up your
servers for floating licenses, and to select the type of license to use for each
package.

* The Roll Back wizard reverts to a previous version of a package.

¢ The Uninstall wizard removes a package from your computer. You can uninstall
more than one package at a time.

For more information, see the [Installation Manager information center]
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Upgrade and coexistence considerations

6

Before installing Rational Programming Patterns, you must install other products
in the same package group. You must then be aware of the compatibility between
the various products to obtain a consistent installation.

Important: You must also ensure that you installed the Pacbase version that
corresponds to the Rational Programming Patterns version. A version
incompatibility can create errors.

General considerations

Some products are designed to coexist and share function when they are installed
in the same package group. A package group is a location where you can install
one or more software products or packages. When you install each package, you
select whether you want to install the package into an existing package group, or
whether you want to create a package. IBM Installation Manager blocks the
products that are not designed to share or do not meet version tolerance and other
requirements. If you want to install more than one product at a time, the products
must be able to share a package group.

When a product is installed, its function is shared with all of the other products in
the package group. If you install a development product and a testing product into
one package group, when you start either of the products, both the development
and testing functionalities are available in your user interface. If you add a product
with modeling tools, all of the products in the package group have the
development, testing, and modeling functionality available.

Note: If you install several packages at the same time, they are all installed in the
same package group.

If you install a development product and later purchase a development product
with increased functionality and add that product to the same package group, the
additional function is available in both products. If you uninstall the product with
the greater functionality, the original product remains

Note: Each product installed into a unique location can be associated with only
one package group. A product must be installed into multiple locations in order to
be associated with multiple package groups.

Each package group is assigned a name automatically. However, you choose the
installation directory for the package group.

When you create the package group by successfully installing a package, you
cannot change the installation directory for the package group. The installation
directory contains files and resources specific to the packages installed into that
package group. Other resources in the packages that can potentially be shared by
other package groups are placed in the shared resources directory.

Important: You can specify the shared resources directory only the first time you
install a package. For best results, use your largest drive. You cannot change the
directory location later unless you uninstall all packages.
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Considerations related to Rational Programming Patterns

When you install Rational Programming Patterns, you must indicate a package
group for all the products of the client part and another package group for all the
products of the server part.

You can install the Rational Programming Patterns V9.0.1 by updating the V9.0 or
V9.0.0.1 version.

You can also carry out a full installation of the new version. You must then choose

one of the following methods:

* Uninstall and reinstall the products in the same package groups.

* Keep the package groups that contain the previous versions of the products and
create package groups to install the new versions of the products. Start working

in the new installation. If everything works fine, you can remove the old
installation. This method is recommended.

If your current Installation Manager version is too old to install Rational
Programming PatternsV9.0.1 and its required products, it will be automatically
updated when you install one of the products from a launchpad.

The client part requires the installation of the following products in the same
package group:

* Rational Developer for System z V9.0 for a System z environment,
 Rational Developer for AIX and Linux V9.0 for a System p environment,

e Rational Team Concert V4.0.3,

* Rational Programming Patterns client V9.0.1.

Note: All the other versions of these products that are available when this version
of Rational Programming Patterns is released are also compatible.

The server part requires the installation of the following products:

* For a Windows, UNIX or Linux environment, install Jazz Team ServerV4.0.3 and
Rational Programming Patterns V9.0.1 server in a server package group.

+ For a z/OS® environment, install Jazz Team Server V4.0.3 and install the
Rational Programming Patterns V9.0.1 FMID.

Note: You can optionally use the functions of the Rational Developer for System
z server. You must then install the Rational Developer for System z V9.0 server
with the SMP/E tool before you install Jazz Team Server V4.0.3 in the same
package group.

Note: All the other versions of these products that are available when this version
of Rational Programming Patterns is released are also compatible.

Installation methods for Rational Programming Patterns

Four installation methods are available.

You must consider the following questions to determine your installation method:

¢ What are the format and method by which you access your installation files?
(for example, from installation disks or files that are downloaded from IBM
Passport Advantage®).

Chapter 3. Planning to install Rational Programming Patterns 7



* Are you installing onto your own workstation, or are making the installation
files available to your enterprise?

* Are you installing with the Installation Manager GUI, or are you installing
silently?

There are four installation methods:

¢ Installing from the installation disks,

* Installing from a downloaded electronic image on your workstation,
¢ Installing from an electronic image on a shared drive,

* Installing from a repository on an HTTP server.

Installing from the installation disks

With this method, you have the physical disks that contain the installation files,
and you install Rational Programming Patterns on your own workstation.

Installing from a downloaded electronic image on your
workstation

With this method, you download the installation files from IBM Passport
Advantage and you install Rational Programming Patterns on your own
workstation.

Installing from an electronic image on a shared drive

With this method, you place the electronic image on a shared drive so that users in
your company can access the Rational Programming Patterns installation files from
a single location. It is also useful when you must install in silent mode on several
user systems.

Installing from a repository on an HTTP server

With this method, you place the files of the IBM Rational Programming Patterns
package, and possibly the associated products, on an HTTP or HTTPS web server
with the IBM Packaging Utility. When they install, users indicate the URL of the
web server that contains these package files to access them. The directory of the
HTTP or HTTPS web server that contains the packages is named a repository.

For more information, see [Chapter 11, “Appendix: IBM Packaging Utility,” on page]

Installing silently

If you install from an electronic image or a repository, you can run Installation
Manager in silent mode.

You can then use a batch process to install, update, modify, and uninstall packages
through scripts. If you are an administrator, it enables you to customize the
installation on the developers' workstations.

A silent installation comprises the following main tasks:

1. If you are planning to install silently on multiple systems, copy the installation
image to a location on a shared drive or server.

2. Create the response file.

8 IBM Rational Programming Patterns Version 9.0.1: Installation Guide



3. Run Installation Manager in silent installation mode.

When you run Installation Manager in silent mode, its user interface is not
available. So you use a response file instead to input the commands that are
required to install the package. An install.xml sample response file is available in
the InstallerImage_win32 subdirectory of the client and in the
InstallerImage_system subdirectory (where systemis aix, 1inux_s390, 1inux_x86,
or win32) of the server. You can use it as is or modify it to your own specifications.

For more information, see [Working in silent modd in the Installation Manager
information center.

Copying the installation image to a shared drive or server

If you are planning to install silently on multiple systems, you must copy the
installation image to a location on a shared drive where other systems in your
intranet can access it.

To copy the installation image from physical installation disks to a shared location,
take the following steps:

1. Insert the Rational Programming Patterns installation disk into the DVD drive.

2. Copy the contents of the disk into the shared location where you want to store
the installation image.

3. You can make other offerings that are bundled with Rational Programming
Patterns (Rational Developer for System z for example) available for silent
installation. Two cases are then possible.

¢ If the bundled offering is contained on a single installation disk, copy the
contents of that installation disk to the directory you created in Step 1.

* If the bundled offering includes multiple installation disks, perform the
following steps.

a. Create a directory in your shared location to contain the product
installation files for the bundled offering. You name this directory as you
want.

b. Create a diskN directory for each installation disk in the directory you
created. N is the number of the installation disk. Copy the contents of
each installation disk into the corresponding diskN directory you created
for that disk.

* Create the response file.

e Perform the silent installations.

To copy the installation image from an electronic image to a shared location, take
the following steps:

1. Extract each of the compressed files that you downloaded for Rational
Programming Patterns and any bundled offerings you want to make available
for silent installations to the shared location where you want to store the image.
Alternatively, you can extract the compressed files on your local workstation
and then copy the uncompressed files and directories to the shared location.

2. In the shared location, verify that you now have the following elements:

* The Rational Programming Patterns installation disks must be at the root of
the shared directory.

* A directory must also be created at the root of the shared directory for each
bundled offering that you copied to your shared location. Create a diskN
directory for each installation. N is the number of the installation disk

Chapter 3. Planning to install Rational Programming Patterns 9
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* Create the response file.
e Perform the silent installations.

Alternatively, you can copy your installation image to a repository on an HTTP
web server and install silently using the repository. To create a repository, you
must use the IBM Packaging Utility. For more information, see [Chapter 11

[“Appendix: IBM Packaging Utility,” on page 39)

10 IBM Rational Programming Patterns Version 9.0.1: Installation Guide



Chapter 4. Installing the required products

Installing VisualAge Pacbase

To obtain VisualAge Pacbase 3.5 Y09B, send an email to the Rational Programming
Patterns support (vapacsup@us.ibm.com for North America or
vapacsup@fr.ibm.com for all other regions).

Follow the installation instructions that are indicated in the VisualAge Pacbase
guide specific to your platform.

The VisualAge Pacbase installation guides are shipped with the VisualAge Pacbase
product. They are also available on the|VisualAge Pacbase documentation site]
(section The administrator's documentation).

Installing the required products for the client part

Installing for a System z client environment

To target a System z client environment only, you must install the Rational
Developer for System z V9.0 client and then the Rational Team Concert V4.0.3
client.

Installing the Rational Developer for System z V9.0 client

Install the Rational Developer for System z V9.0 installation package. Do not clear
any of the features that are selected by default on the Features page of Installation
Manager.

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing the Rational Team Concert V4.0.3 client

You can install Rational Team Concert from its installation disk or electronic image.
But you can also install it as an optional feature to the Rational Developer for
System z client.

Important: The Rational Team Concert V4.0.3 client must be installed in the same
package group as the Rational Developer for System z V9.0 client.

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing for a System p environment

To target a System p environment only, you must install Rational Developer for
AIX and Linux V9.0 and then the Rational Team Concert V4.0.3 client.

© Copyright IBM Corp. 2010, 2013 11
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Installing Rational Developer for AIX and Linux V9.0
Install the Rational Developer for AIX and Linux V9.0 installation package.

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing the Rational Team Concert V4.0.3 client
You can install Rational Team Concert from its installation disk or electronic image.

Important: The Rational Team Concert V4.0.3 client must be installed in the same
package group as the Rational Developer for AIX and Linux V9.0 client.

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing the product required for the server part

12

Before you install the Rational Programming Patterns server, you must install Jazz
Team Server and CCM Application V4.0.3.

* If you install on Windows 2008, AIX, Linux, or Linux for System z, the Jazz
Team Server and CCM Application V4.0.3 must be installed with Installation
Manager.

Verify that the IBM Installation Manager page that displays the installation
results shows: The packages are installed. There must not be any error or
warning icon. Moreover the list of the installed packages must contain all the
packages of the products that were selected for the installation.

 If you install on z/OS, the Jazz Team Server and CCM Application V4.0.3 must
be installed with SMP/E.

Note: Installing the Rational Developer for System z host components is not
required for using the Rational Programming Patterns server. However, if you
want to use Rational Developer for System z specific functions, you can install the
Rational Developer for System z server.

IBM Rational Programming Patterns Version 9.0.1: Installation Guide



Chapter 5. Installing Rational Programming Patterns

Installing the Rational Programming Patterns client

After installing the products required for your target environment, you must install
the Rational Programming Patterns client on Windows Vista, Windows XP
Professional, or Windows 7 Professional. You install it from its launchpad.

Before you begin

The Rational Programming Patterns client must be installed in the same package
group as the products required for the client part, with the same type of rights
(administrator or user). Moreover, Microsoft Visual C++ Redistributable Package
must already be installed.

To select the installation method that is best suited to your needs, see the
information in [“Installation methods for Rational Programming Patterns” on page|

You start installing in different ways, depending on the selected method:
¢ Installing from an installation disk.
1. Insert the installation disk into your DVD drive.
2. To start installing, open the Rational Programming Patterns launchpad.

If autorun is enabled on your system, the launchpad program automatically
opens. If autorun is not enabled, start the launchpad program by running the
Taunchpad.exe command from the root of the disk.

¢ Installing from an electronic image on your workstation.

1. Download the installation files from IBM Passport Advantage. Extract the
installation image from the compressed files that you downloaded.

2. To start installing, open the Rational Programming Patterns launchpad.

You start the launchpad program by running the Taunchpad.exe command
from the root of the extracted directory

* Installing from an electronic image on a shared drive.

Download the installation files from IBM Passport Advantage. Extract the
installation image from the compressed files that you downloaded

To install interactively from the installation files on the shared drive, run the
Taunchpad.exe command from the root of the extracted directory.

You can also install in silent mode. For explanations, see the note in the
[“Installing silently” on page 8|

* Installing from a repository on an HTTP web server.

This method assumes that the repository that contains the packages for IBM
Rational Programming Patterns and any bundled offerings has been created on
the HTTP or HTTPS web server. For information about how to copy installation

packages to a web server, see [Chapter 11, “Appendix: IBM Packaging Utility,” on|
ﬁ

To install the Rational Programming Patterns package from a repository to a web
server, perform the following steps:

1. Start IBM Installation Manager.
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2. On the Start page of Installation Manager, click File > Preferences and then
click Repositories. The Repositories page opens, showing any available
repositories, their locations, and whether they are accessible.

3. Click Add repository and indicate the URL of the repository that contains
the installation packages. The new or changed repository location is listed. If
the repository is not accessible, an error icon is displayed in the Accessible
column.

4. Click OK to exit.

Procedure

1.

7.

From the Rational Programming Patterns launchpad, select Install Rational
Programming Patterns to open Installation Manager.

The repository location information is automatically configured. So you do not
have to set it manually in the Installation Manager preferences.

The first page of the Install Packages wizard displays the Rational
Programming Patterns package available for installation. Select it.

You might be prompted to update IBM Installation Manager to a newer version
if one is available. If you click Yes, Installation Manager updates itself and
informs you that it must be restarted to complete the update. Click OK to
restart Installation Manager

On the Licenses page, read and accept the license agreement for the selected
package. Rational Programming Patterns will be installed with a trial license
that expires in 60 days. You will need to activate the licensed version of the
product to use it after the expiration date.

On the Location pages, the location that already contains the products required
for the client part must be selected.

On the first Features page, select the languages that you want to install for this
package group.

On the next Features page, select the features that you want to install. A line
RPP Screen simulator (for an installation on top of RDz) is displayed under
the Rational Programming Patterns package.

* If you install Rational Programming Patterns on top of Rational Developer
for System z, select this line. It enables you to see the simulation of the
Rational Programming Patterns Screens in the Screen emulator view, which
is dedicated to this use.

¢ If you install Rational Programming Patterns on top of Rational Developer
for AIX and Linux, this line is ineffective. See the help on the -CE Lines tab
of the Screen entity for explanations on how to start the emulator on this
environment.

On the Summary page of Installation Manager, click Install.

Results

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Installing the Rational Programming Patterns server

You can install the Rational Programming Patterns server either on Windows 2008,
AIX, Linux, Linux for System z, or on z/OS.
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Before you begin

Jazz Team Server V4.0.3 must already be installed

The Rational Programming Patterns server must be installed in the same package
group as the Jazz Team Server V4.0.3 with the same type of rights (administrator
Or user).

Installing the server on Windows, AIX, or Linux

You access the installation files of the server from its installation disks, electronic
image, or an HTTP or HTTPS server.

Procedure

1.

Depending on the installation method you selected, you must perform one of
the following actions:

Insert its installation disk into the DVD drive.

Download its electronic image from the IBM Passport Advantage website
and extract all the compressed files. If you are an administrator, you can
make them available on a shared drive.

Access a repository on an HTTP web server.

For explanations, see the [“Installation methods for Rational Programming]
[Patterns” on page 7]

The contents of the installation disk and the extracted electronic image are the
same:

A docs directory, with the relevant documentation.
A distributed directory that contains:

— A diskl subdirectory, with the Rational Programming Patterns server
repository.

— Four InstallerImage_system subdirectories, where system is aix,
Tinux_s390 (Linux for System z), 1inux_x86 or win32 (for Windows). These
subdirectories contain the repository for Installation Manager and the
executable files of the Rational Programming Patterns server, adapted to
the operating system.

Each of these directories also contains an install.xml sample response file
for the installation in silent mode.

— For UNIX, the instal1RPP_system_admin.sh and
instalTRPP_system_user.sh script files, where system is aix, 1inux_s390
(Linux for System z) or 1inux_x86. Each of these scripts starts the
installation of the Rational Programming Patterns server, according to the
selected operating system. The installation is automatically carried out
from Installation Manager, with administrator or user rights, with all the
preferences and selections already entered for you.

— Two batch command files instal1RPP_win32_admin.bat and
instal1RPP_win32_user.bat, which start the Rational Programming
Patterns server installation on Windows. The installation is automatically
carried out from Installation Manager, with administrator or user rights,
with all the preferences and selections already entered for you.

2. To perform a standard installation, run one of the following files:

* One of the script files for AIX, Linux, or Linux for System z

(installRPP_system_admin.sh or instalTRPP_system user.sh).
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* The instalTRPP_win32_admin.bat or instal1RPP_win32 user.bat file for
Windows 2008.

To specify your own installation selections, install the server from one of the
four subdirectories (InstallerImage_system). Open Installation Manager, enter
the path to the Rational Programming Patterns server repository and select
your preferences on all the Installation Manager pages.

Installing the server on z/OS

To install the Rational Programming Patterns V9.0.1 server on z/OS, you must
install the HAKF901 FMID on the server already installed.

Procedure
. Access the files that are required to install the Rational Programming Patterns

server on z/0S, by performing one of the following actions:
* Insert its installation disk into the DVD drive.

* Or download its electronic image from the IBM Passport Advantage website
and extract all the compressed files. If you are an administrator, you can
make them available on a shared drive.

The contents of the installation disk and the extracted electronic image are the
same:

* A docs directory, with the relevant documentation.

This directory contains the HAKF901.pdf installation guide (Program
Directory). It contains all the instructions to install the Rational Programming
Patterns server on z/0S, through SMP/E.

* A zos directory that contains a compressed file for the installation through
SMP/E. This file contains the following installable parts of the HAKF901
FMID:

— IBM.HAKF901.F1.BIN,
— IBM.HAKF901.F2.BIN,
— IBM.HAKF901.JCL.BIN
— IBM.HAKF901.SMPMCS.

. Follow the instructions of the Program Directory in the docs directory.
. In z/OS, parametrize and run the BRPCPCCM JCL to copy the rpp-profile.ini

file to the directory that will contain all the applications customized
configuration files.

The BLZHOME, BLZCONF, and BLZWORK parameters must be identical to those of the
BLZCPCCM JCL.
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Chapter 6. Post-installation tasks

Integrating with Rational Team Concert

Rational Programming Patterns is now installed on top of IBM Rational Team
Concert. You must configure Rational Team Concert to integrate Rational
Programming Patterns with it.

About this task

The purpose of this integration is to prepare the building of indexes in the Rational
Programming Patterns server. You must carry out the following actions:

¢ From the Rational Team Concert web client, ensure that the user has the
required permissions for the configuration,

¢ From the Rational Team Concert Eclipse client, create a project area (if it has not
already been done),

* From the Rational Team Concert Eclipse client, create three language definitions
and associate indexing scanners to them,

* From the Rational Team Concert Eclipse client, select the data streams that will
be scanned.

For an optimum integration, you are advised to modify some default parameters.

Note: After successive installations of reinstallations, the server cache might be

desynchronized with the actual server configuration. For example, the Rational

Programming Patterns scanners might not be displayed. So, the language

definitions that are related to Rational Programming Patterns cannot be correctly

specified. You must then reset the cache.

1. Log in as an administrator to https://[fully-qualified hostname] :9443/ccm/
admin?internal.

2. In the Internal tools entry, click Provision status. All the contributors to the
Rational Team Concert, server are displayed. If the Rational Programming
Patterns plug-ins are displayed among these contributors, you must reset the
cache.

3. To reset the cache, click Reset server that is located after Provision status.

4. Click the Request server reset button. The cache will then be reset the next
time that the server is started.

5. Stop and start the server again. The server start takes longer than a standard
start because the cache is reset.

Procedure
1. Create a user and assign permissions to this user:
a. Start the Jazz Team Server and open its setup wizard
(https://[fully-qualified hostname]:9443/jts/setup)

Follow all the steps explained in the Rational Team Concert documentation:
[Running the setup wizard]

b. Create a user, if it has not already been done.

C. Assign this new user a Developer for IBM Enterprise Platforms Client
Access License.
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d. Verify that the created user has all the repository permissions and the
Developer for IBM Enterprise Platforms Client Access License.

2. Create a project area:
a. Start Rational Programming Patterns.
b. Open the Work Items perspective.
C. In the Team Artifacts view, create a repository connection at:
https://[fully-qualified hostname]:9443/ccm
with the administrator user already created.

d. Create a project area.

Note: Explanations about project areas can be found in the |[Rational Tea

[Concert information center

3. Verify the access permissions:

As an administrator, you must verify that the user who is to create the

language definitions for the Rational Programming Patterns artifacts has the

appropriate access permissions.

a. From the Work Items perspective of the Eclipse workspace, open the project
area by right-clicking it and selecting Open.

b. On the Overview tab of the project area, verify the role that is assigned to
the user who is to create the language definitions.

c. Open the Process Configuration tab. Expand Project Configuration in the
Configuration tree and select Permissions. In the list of Roles, select the
role of the user who is to create the language definitions. In the Permitted
actions tree, verify that the lines Language Definitions and Source Code
Data are selected.

& Project Area -

Rational Programming Patterns |

= Configuration oy = Permissions

- Roles Configure which actions are permitted for each role. & user can perform all actions granked to any of their assigned roles. &l users in & repository have the
L ) implicit "Everyone” rale.

| Project Configuration

&| Project Area Initialization (¥ Show actions by role () Show all actions and roles
é-f Permissions 2 3
& Operat Roles: Permitted actions:
T Event ii Stakeholder Language Definitions

" Configuration Data f} Contributor

| Team Configuration

Source Code Data

T bl T

5} Project Manager

A team member leading a team.

|Process Configuration [Process Corfiotration Source | Access Contral work [iem Categories | Releases.

Figure 1. The Process Configuration tab

d. Save.
4. Create the language definitions and select the associated scanners:

You can now create three language definitions:
e RPP Design,
* RPP Design Path,
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* RPP Generated.

a. Expand the project area in the Team Artifacts view. Then, expand
Enterprise Extensions > System Definitions > z/OS. Right-click Language
Definitions and select New Language Definition. The Language Definition
editor opens up. It contains a General tab and a Scanners tab.

@ Work Items - - IBM Rational Developer for System z

=[Ok

3 c- B2
#-C Repository Connections
=& Test [locahost]
-, Builds
=+, Enterprise Extensions
(& Context-Aware Search
-5 Deployments
-5 Packages

Language Definition

Name:

General
Specify a language for this language definition. Optionally, file extensions

can be specified to automatically assodiate files with this language definition.

Description:

Fle Edit Navigate Search Project Run Window Help

S ERA I = L T S R RS e e & | B work Items |
| Team Artfacts £2 . g My work|  ~ 5| <unttled> 22 - E
My Fiter (1 of 1 areas selected)

Translators
Specify and order translators for this language

defintion. Translators wil run in order during the
build.

@5 Promotions

@ 7 Source Code Data . =
=l System Definitions Edit
=W z/os Language: ‘:E] S
-, Data Set D
@[ Plans
{5, Reports
- L Source Control
(5 Work Items
w-L3 Debug
.--[% Favorites
-l Feeds
[ My Repository Workspaces
-5 My Team Areas
L Wiarke Trem Hictning

5

i

New Language Definition

Eions are separated by a comma, e.g. "cbl,cob”
«# Refresh F5

Gen eral| Scanners|

Figure 2. The Language Definition editor

b. Create the language definition for the design artifacts.
1) In the General tab:
* Enter RPP Design in the Name field.

* Enter an optional description, such as RPP Design File Scanner, in
the Description field.

* Select COBOL in the Language field.
* Enter the following file extensions in the File Extensions field:

dataaggregate,dataelement,dataunit,pacblockbase,pacdialog,pacscreen,
pacdialogserver,pacserver,paclibrary,pacmacro,pacprogram,pacreport,pacinputaid,
pactext,metaentity,userentity,metadataaggregate,metaentitytype

Important: Only these file extensions are used by Rational
Programming Patterns. Wildcards cannot be used.

2) In the Scanners tab, remove the default scanner and add the RPP Design
Scanner for this language definition.

3) Save.
c. Create the language definition for the design path artifacts.
1) Select New Language Definition again.
2) In the General tab:
e Enter RPP Design Path in the Name field.

* Enter an optional description, such as RPP DesignPath File Scanner,
in the Description field.
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¢ Select COBOL in the Language field.
* Enter the following file extension in the File Extensions field:

designpath

Important: Only this file extension is used by Rational Programming
Patterns. Wildcards cannot be used.

3) In the Scanners tab, remove the default scanner and add the RPP

DesignPath Scanner for this language definition.

4) Save.
d. Create the language definition for the generated artifacts.

¢ Select New Language Definition again.
* In the General tab:

Enter RPP Generated in the Name field.

Enter an optional description, such as RPP Generated File Scanner, in
the Description field.

Select COBOL in the Language field.

Enter the following file extensions in the File Extensions field:
cb1pdp,bmspdp,mappdp,mfspdp

Important: Only these file extensions are used by Rational
Programming Patterns. Wildcards cannot be used.

In the Scanners tab, remove the default scanner and add the RPP
Generated File Scanner for this language definition.

Save.

5. Associate data streams with the language definitions:

Specify which streams are to be scanned. In the Team Artifacts view, under
Enterprise Extensions, right-click Source Code Data. Then, click Select streams
for scanning. Specify the stream.

If you cannot see any steam, you must create one before you select it. Follow
the instructions of [Creating steams| in the Rational Team Concert
documentation.
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Figure 3. How to access the stream selection wizard

6. Modify parameters
* Memory parameters of the client workstation:
— eclipse.ini

You must modify the memory parameter of the Software Delivery
Platform. Its maximum value varies according to the operating system and
the memory available. You must then find the maximum value for your
configuration.

To do so, edit the eclipse.ini file that is located directly under the root of
your Software Delivery Platform.

The Java™ heap size is set to 1024 by default (in -Xmx1024m). You can
increase this value to adapt it to your configuration.

Note: For an installation in 32-bit mode, the maximum value is 1.5
gigabyte.
— scm.ini

The migration of data from Pacbase to Rational Programming Patterns
uses the scmtools to save the migrated data in Rational Team Concert

You must modify the scm.ini file like the ecTipse.ini file.

The scm.ini file is in ...\scmtools\eclipse. The Java heap size is set to
512 by default (in -Xmx512m).

* Memory parameter of the server:

You can adapt the server.startup.bat file that is in the ...\server directory.
In a 64-bit environment, and if the server allows it, you can modify the line
set JAVA_OPTS=%JAVA_OPTS% -Xmx4G to increase the maximum memory in use
to 8G.

* Properties of the Rational Team Concert server:

— No creation of duplicate components:
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By default, the component names are not unique in the Rational Team
Concert repository. To avoid inconsistencies, an administrator is then
advised to prevent users from creating components whose names are not
unique.

a. Log in as an administrator to https://[fully-qualified
hostname] :9443/ccm/admin.

In the Configuration entry, click Advanced properties.

Scroll the properties down to the SCM category. Scroll the category
down to com.ibm.team.scm.service.internal.tasks.InternalScmService.

d. Find the property Encourage component names to be unique.

e. Click its current value (false by default) and change it to true.

f. Click the Save button that is at the beginning of the properties page.
— Maximum number of files in source code data resource:

With this modification, you avoid a too large memory consumption.

a. Log in as an administrator to https://[fully-qualified
hostname] :9443/ccm/admin.
In the Configuration entry, click Advanced properties.
Scroll the properties down to the Source code data collection category.
This category contains the line
com.ibm.team.enterprise.internal.metadata.collection.service. Metadata
CollectionService.

d. Change the value of the property Max. number of files in source code
data resource. Click its current value and enter 100 instead.
* DB2 parameter:

To run Rational Team Concert with a DB2® database, you can see the jazz.net
site for information about the DB2 tuning. To import large DB2 databases,
you must increase the following values:

db2 UPDATE DB CFG FOR CCM using LOGPRIMARY 100
db2 UPDATE DB CFG FOR CCM using LOGSECOND 100

where 100 is the increased value. To see the values, use the following
command: :

db2 GET DB CFG FOR sample |grep '(LOG[FPS]"

You obtain the following values:

Size of journal files (4 Kb) (LOGFILSIZ) = 1000
Number of primary journal files  (LOGPRIMARY) = 3
Number of secondary journal files (LOGSECOND) = 2

Results
The configuration steps are now finished.

When you deliver a project that contains Rational Programming Patterns artifacts,
the artifacts will be indexed after the indexing process has been manually or
automatically activated. You will then be able to perform searches on the server
repository.

Creating a Rational Programming Patterns V9.0.1 workspace

You cannot reuse a workspace that was created with a previous version of the
product.
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Rational Programming Patterns V9.0.1 cannot run with the VisualAge Pacbase data
that was migrated from a previous version. So, you must run the VisualAge
Pacbase 3.5 Y09B extraction and migration procedures.

Then, you must create a V9.0.1 workspace to import the data.

Accessing the help

The help that Rational Programming Patterns accesses after its installation is the
remote help, which requires an Internet connection. With this remote help, you
always have the latest content available from within your product. After you start
the product, you can also install the help locally.

By default, Rational Programming Patterns is configured to access the remote help
from the product information center, at:

http:/ /pic.dhe.ibm.com/infocenter/rpphelp/v9r0/index.jsp

When you install, you cannot select the way that the help is accessed. However,
you will be able to modify it later at any moment.

Note: In the links below, the explanations about how to choose the access mode to
the help upon installation do not apply to Rational Programming Patterns. All the
other explanations apply.

For more information about installing and configuring help, see the section
[Configuring help content|

To install the help content locally, see one of the following topics:

+ Downloading help content from the [Help updater sitel

+ Downloading help content from the [Help download site]

Note: Downloading help content from the help download site uses the
RPP901_updateSite.zip file. If you do not have internet access, this file is also
available in the docs directory of the Rational Programming Patterns installation
disks and images. However, it is advised to use the version from the help
download site because it is the most up-to-date version.

Managing licenses

Licensing for your installed IBM software and customized packages is
administered with the Manage Licenses wizard in IBM Installation Manager. This
wizard displays license information and helps you configure the licences for each
of your installed packages.

The license that is provided with Rational Programming Patterns expires 60 days
after installation. You must activate Rational Programming Patterns to use it after
the expiration date.

Using the Manage Licenses wizard, you can upgrade the trial version to a licensed
version by importing an activation kit. You can also enable floating license
enforcement for offerings with trial or permanent licenses to use floating license
keys from a license server.

Chapter 6. Post-installation tasks 23


http://pic.dhe.ibm.com/infocenter/rpphelp/v9r0/index.jsp?topic=%2Fcom.ibm.help.common.rational.remote.doc%2Ftopics%2Ft_configuring_help.html
http://pic.dhe.ibm.com/infocenter/rpphelp/v9r0/index.jsp?topic=%2Fcom.ibm.help.common.rational.remote.doc%2Ftopics%2Ft_download_help_update_site.html
http://pic.dhe.ibm.com/infocenter/rpphelp/v9r0/index.jsp?topic=%2Fcom.ibm.help.common.rational.remote.doc%2Ftopics%2Ft_download_help_download_site.html

24

For more information about the Rational Programming Patterns licenses, see the
[Rational licensing support page}

License types

You can buy different types of licenses.
Authorized user license

This license enables a single, specific individual to use a Rational software product.
Purchasers must obtain an authorized user license for each individual user who
accesses the product in any manner. An authorized user license cannot be
reassigned unless the purchaser replaces the original assignee on a long-term or
permanent basis.

Floating license

This license is for a single software product that can be shared among multiple
team members. However, the total number of concurrent users cannot exceed the
number of floating licenses you purchase. For example, if you purchase one
floating license for a Rational software product, then any user in your organization
can use the product at any time. Another person who wants to access the product
must wait until the current user logs off.

To use floating licenses, you must obtain floating license keys and install them on a
Rational License Server. The server responds to user requests for access to the
license keys. It grants access to the number of concurrent users that matches the
number of licenses that the organization purchased.

Token license

The token-based license model means that you can buy some token licenses.

Token-based licenses can be used with floating licenses only. They cannot be used
for authorized user license

License enablement

If you are installing Rational Programming Patterns for the first time or want to
extend a license to continue using it, you have options on how to enable licensing.

Licenses are enabled in the following two ways:
e Importing a product activation kit
* Enabling Rational Common Licensing to obtain access to floating license keys

Product activation kits contain permanent or term license keys. You purchase the
activation kit, download the activation kit .zip file to your local workstation, and
then import the activation kit . jar file to enable the license. Use IBM Installation
Manager to import the activation kit to your product.

Optionally, you can obtain floating license keys, install IBM Rational License
Server, and enable floating license enforcement for your product. Floating license
enforcement provides the following benefits:

* License compliance enforcement across the organization

* Fewer license purchases
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Importing a product activation kit
To install your license key, you must import the activation kit from the download
location or the product media by using IBM Installation Manager.

About this task

You must first purchase an activation kit. Insert the appropriate disk or download
the activation kit from IBM Passport Advantage to an accessible workstation. The
activation kit is packaged as a Java archive (.jar) file. The .jar file contains the
permanent license key and must be imported to activate your product.

Procedure

1. Start IBM Installation Manager.

2. On the main page, click Manage Licenses.

3. Select the Rational Programming Patterns package and click Import Activation
Kit.

4. Click Next. Details for the selected package are shown, including the current
license type and the version range of the license.

5. Browse to the path on the media disk or download the location for the
activation kit. Then, select the appropriate Java archive (.jar) file and click
Open.

6. Click Next. The Summary page displays the target installation directory of the
activation kit, the product that the new license applies to, and version
information.

7. Click Finish.
Results

The product activation kit with its license key is imported to the product. The
Manage Licenses wizard indicates whether the import is successful

Activating floating licenses

If your team environment supports floating license enforcement, you can activate
floating licenses for your product and configure a connection to obtain access to
floating license keys.

About this task

Before you activate floating license enforcement, you must obtain the license server
connection information from your administrator.

Procedure
1. Start IBM Installation Manager.
2. On the main page, click Manage Licenses

3. Select the appropriate Rational Programming Patterns package and click
Configure Floating license support.

4. Click Next

On the Licenses page, accept the license agreement for the selected package

o

6. On the Floating License Support page, select the Enable Floating license
enforcement.

7. Configure one or more license server connections by following these steps:
a. Click an empty field in the Servers table or click Add.
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b. If your administrator provided you with information for a redundant
server environment, click Redundant Server. Fields for the primary,
secondary, and tertiary server names and ports are displayed.

c. Enter the host name of the license server in the Name field.

d. (Optional) Enter a value in the Port field for environments where a
firewall is used. Do not assign a value to this port unless your
administrator instructs you to do so.

e. For redundant server environments, enter the names and ports (if
required) for the secondary and tertiary servers

f. (Optional) You can click Test Connection to confirm that the connection
information is correct and that the server is available.

g. Click OK.
8. Click Next.

9. (Optional) Configure the license usage order for your shell shared or custom
packages. The order of licenses in the list determines the order in which your
package attempts to obtain access to license keys for a given licensed package.

10. Click Finish.
Results

The Manage Licenses wizard indicates whether the floating licenses configuration
is successful.

When you next open the enabled product, a connection is created to the license
server to obtain a license key from the pool of available floating license keys.

Purchasing licenses

You can purchase new licenses if your current product license is about to expire or
if you want to acquire more product licenses for team members.

Procedure
1. Determine the type of license you want to purchase

2. Go to ibm.com® or contact your IBM marketing representative to purchase the
product license. For details, visit the IBM web page on “How to buy software”.

3. Depending on the type of license you purchase, use the Proof of Entitlement
you receive and do one of the following to enable your product:

¢ If you purchase authorized user licenses, go to Passport Advantage and
follow the instructions there for downloading your product activation kit file.
After you download the activation kit, you must import the product
activation .jar file with Installation Manager.

* If you purchase floating licenses, connect to the [[BM Rational License Key]|
An IBM registration is required. You can use your Proof of
Entitlement to obtain floating license keys for your license server.

Optionally, you can also go to Passport Advantage to download the
activation kit for your product. After you import the activation kit, you can
switch from a floating to a permanent license type if you use work offline for
long periods.

To import the activation kit or enable floating license support for your product,
use the Manage Licenses wizard in IBM Installation Manager.
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Installing and configuring licenses in silent mode

You can import product licenses and configure floating license support silently, in
the same way you can install packages silently.

You must generate a response file to be used by IBM Installation Manager to
configure your licenses.

When you record the response file, use the Manage Licenses wizard to import an
activation kit or configure floating license support before you exit Installation
Manager. The information necessary for performing these tasks silently are written
in the response file.

For information about silent installation, see [“Installing silently” on page 8

Viewing license information

From IBM Installation Manager, you can review the license information of your
installed packages, including the license types and their expiration dates.

Procedure
1. Start IBM Installation Manager.
2. On the main page, click Manage licenses.
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Chapter 7. Starting Rational Programming Patterns

You can start Rational Programming Patterns from the Windows desktop
environment or the command-line interface.

About this task

To start Rational Programming Patterns from the Windows Start menu, click Start
> All Programs > IBM Software Delivery Platform > IBM Rational Programming
Patterns. You can then create a shortcut on your desktop to easily start Rational
Programming Patterns.

To start Rational Programming Patterns from a command line, type
<product_inst_dir>eclipse.exe -product com.ibm.rational.rpp.product.ide
The Pattern Driven Programming perspective is automatically added to your

workspace and it becomes the default perspective. The PDP editors also become
the default editors.
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Chapter 8. Testing the installation

Before you can work with the new products, you must ensure that the installation
was successful.

Procedure

1. At the end of each product installation, you must ensure that no error has
occurred. This verification step is indicated in this document for each
installation.

2. Verify that all the products of the client part are installed in the same package
group and that all the products of the server part are installed in the same
package group (different from the package group of the client part).

To do so, start IBM Installation Manager by selecting Start > All programs >
IBM Installation Manager > View installed packages. You must see the
package group that contains Rational Programming Patterns client. Verify that
this group also contains the packages of the required products.

Do the same for the server part.

3. Start Rational Programming Patterns. The Pattern Driven Programming
perspective is automatically displayed.

a. From the Design Explorer view, create a location (similar to a VisualAge
Pacbase database). Right-click and select New > Location. Name this
location and click Finish.

b. Create a Library. It contains the generation parameters of each instance.
1) Right-click the location and select New > Pac Library.
2) Enter the following information in the Library creation wizard:
¢ Indicate a project name.
* Leave the package to blank.
* Enter the Library name on three characters.
 Enter the Library label.
3) Click Finish.
c. Create a Data Element.
1) Right-click the location and select New > Pac Data Element.
2) Enter the following information in the Data Element creation wizard:

* Leave the default project. This project is the project in which you
created the Library.

* Leave the package to blank.

* Enter the Data Element name on six characters maximum.
* Leave the Parent Data Element to blank.

* Enter the Data Element format (X for example).

* Click Browse in the Generation parameters field. Select the created
Library.
* Enter the Data Element label.
3) Click Finish.
4. Create a connection to the Rational Team Concert server that will store all the

artifacts of your applications. These steps are explained in [“Integrating with|
[Rational Team Concert” on page 17
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10.

a. Start Jazz Team Server.

b. Create a repository connection from the Team Artifacts view of the Work
Items perspective.

c. Connect to the project area created upon the integration.

d. From the project area, verify that three language definitions were created
upon the integration. Expand Enterprise Extensions > System Definitions
> z/OS > Language Definitions, Each of these new language definitions
must be exclusively associated with one of the following scanners:

* RPP Design Scanner
* RPP DesignPath Scanner
* RPP Generated File Scanner

In the project area, create a stream on the server by right-clicking Source Code
Data and by selecting New > Stream. Save.

Create a repository workspace from this stream by selecting New >
Repository workspace. You can optionally modify the default name. Then,
click Finish.

Share the project in which you created the Library and the Data Element.

a. In the Design Explorer view of the Pattern Driven Programming
perspective, right-click the project and select Team > Share project.

b. Select the repository type (Jazz Source Control) and click Next.

C. Select the repository workspace and create a component by clicking New

component. Its name usually corresponds to the Library name on three
characters.

d. Select the component.
e. Start sharing the project by clicking Finish.

Upload the new Library and Data Element to the Rational Team Concert
server.

a. Open the Pending changes view.

b. Expand the component line and expand the Outgoing > Share projects
line. The two new instances must be displayed under the project indicated
in their creation wizards.

C. Select the line Share projects. Right-click and select Deliver. The changes
are then uploaded to the server.

Verify that the upload completed successfully and that the two instances are
now on the server.

In the Team Artifacts view of the Work Items perspective, expand your
project area. Verify that the component is in the stream by expanding Source
control. Display the repository files by right-clicking the component and
selecting Show > Repository files. The Library and the Data Element must be
displayed in the Repository files view.

Verify that the server indexing processed by the Rational Programming
Patterns scanners is active.

a. In the Team Artifacts view of the Work Items perspective, start an
incremental update of the indexes. Expand Enterprise Extensions > Source
code data. Right-click and select Update Source code data.

b. Start a server search on the Rational Programming Patterns artifacts to
extract the two instances that were previously uploaded to the server.
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Chapter 9. Updating Rational Programming Patterns

IBM periodically provides updates for Rational Programming Patterns. So the latest
updates can be installed as soon as they are available. You can access these updates
from the IBM update server or from a compressed file that you download from Fix
Central. To update the Rational Programming Patterns server that is installed on
z/0S, you must apply the PTF that is available with the fix.

Updating from the IBM update server

With the package updating function of IBM Installation Manager, you can identify
and install the updates for the Rational products that are installed on your
workstation. You must install with the same Windows account that originally
installed the IBM Rational Programming Patterns product.

Before you begin

By default, an Internet access is required to install updates unless your repository
preferences point to a local or network update repository to which your system has
access.

Each installed package integrates the URL of its IBM update repository by default.
To make IBM Installation Manager search for the packages installed in the IBM
update repositories, the option Search service repositories during installation and
updates must be selected in the repositories preferences page. It is selected by
default.

Note: Close all the programs that were installed with Installation Manager before
updating.

Procedure

1. On the Start page of Installation Manager, click Update. The update wizard
opens up.

2. If a new release or an update of IBM Installation Manager is found, you must
continue with the installation of the new release or update. Follow the
instructions in the wizard to complete the installation or update of Installation
Manager

3. On the Update packages page, select the package group that contains the
version of the Rational Programming Patterns to be updated. Click Next.

IBM Installation Manager searches for updates in its repositories and the
predefined update sites for Rational Programming Patterns. A progress
indicator is then displayed.

4. If updates are found, they are displayed in the Updates list on the Update
Packages page below their corresponding package. Only the recommended
updates are displayed by default. Click Show all to display all updates found
for the available packages.

* To learn more about an update, click the update and review its description
under Details.
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* If more information about the update is available, a More info link is
included at the end of the description text. Click the link to display the
information in a browser. Review this information before installing the
update.

5. Select IBM Rational Programming Patterns and its new version. Select any

other required or optional updates from the list. You cannot select any of the
updates that are already installed.

Note: You can click Select Recommended to restore the default selections.
Updates that have a dependency relationship are automatically selected and
cleared together

6. Click Next.

7. Read the license agreements for the selected updates. If you agree to their
terms, click I accept the terms of the license agreements. Click Next.

Rational Programming Patterns will be installed with a trial license that
expires in 60 days. You will need to activate the licensed version of the
product to use it after the expiration date.
8. Select the features to be updated and click Next.
9. Review your selections on the Summary page.
 If you want to change the choices you made on previous pages, click Back,
and make your changes
* When you are satisfied, click Update to download and install the updates.
A progress indicator shows the percentage of the installation completed.

10. Click Finish to close the wizard.
Results

Verify that the IBM Installation Manager page that displays the installation results
shows: The packages are installed. There must not be any error or warning icon.
Moreover the list of the installed packages must contain all the packages of the
products that were selected for the installation.

Updating from a compressed file

Ideally, this update should be installed directly from the IBM update server.
However, you can also download a compressed file that contains the update.

About this task

You can select this method in the following cases

* You have a slow or unstable Internet connection and want to use a download
manager that can resume the download.

* You have difficulty accessing the live IBM update servers from behind a firewall.
* You prefer to download the update and install it later.

Procedure
1. Connect to the [[BM Fix Central| site.

a. Select the Rational product group, the Rational Programming Patterns
product, its version, and the platform. Click Next.

b. Select Show fixes that get me to this version and click Next.

c. Select IBM Rational Programming Patterns followed by the version and
click Next.
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6.
7.

d. Sign in.

e. Select your download option and click Next.

f. Click Download now.

Extract the content of this file to a folder on your system.

Start IBM Installation Manager by selecting, by default, Start > All Programs >
IBM Installation Manager > IBM Installation Manager.

From the menu bar, select File > Preferences to specify the location of the
extracted file.

On the Repositories page, click Add repository. Browse to the extraction
directory. This directory contains subdirectories. Expand the subdirectory that
corresponds to the client or server installation and select diskTag.inf. Click OK.
Click Test connections to ensure that the new repository can be found.

Click OK.

What to do next

The local repository is now set. Follow the procedure that is described in

[“Updating from the IBM update server” on page 33)

Updating the server on z/OS

To update the Rational Programming Patterns server that is installed on z/OS, you
must apply the PTF that is available with the fix.

Procedure

1.

Allocate host data sets for the fix

A sequential data set must be allocated on z/OS to receive the fix that you will
upload from your workstation. You can do it by submitting the job below. Add
a job card and modify the parameters to meet requirements of your site before
you submit it.

Note: The following code contains the generic values HXXXXXX and UXXXXXX. You
must replace them with the actual values that are available on the support
website

//ALLOC EXEC PGM=IEFBR14

/1*

/ JUXXXXXX DD DSN=hTq.IBM.HXXXXXX.UXXXXXX,
// DISP=(NEW,CATLG,DELETE),
// DSORG=PS,

// RECFM=FB,

// LRECL=80,

// UNIT=SYSALLDA,

//* VOL=SER=volser,

//* BLKSIZE=6160,

// SPACE=(TRK, (103,20))

/1%

Upload the fix from your workstation to z/OS

Upload the file in binary format from your workstation to the z/OS data set.
On a Windows system, you can use FIP from a command line to upload the
file. The table shows the commands that are entered by the user, and the values
that are assumed.

User enters: Values

mvsaddr TCP/IP address of the z/OS system
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User enters: Values

tsouid TSO user ID

tsopw TSO password

d: Drive that contains the fix files

hlq High-level qualifier that you used for the
data set that you allocated in the job above

C:\>ftp mvsaddr

Connected to mvsaddr.

220-FTPD1 IBM FTP CS %version% at mvsaddr, %time% on %date%.
220 Connection will close if idle for more than 60 minutes.

User (mvsaddr:(none)): tsouid
331 Send password please.

Password: tsopw
230 tsouid is logged on. Working directory is "tsouid.".

ftp> cd ..
250 "" is the working directory name prefix.

ftp> cd hlq
250 "h1q." is the working directory name prefix.

ftp> binary
200 Representation type is Image

ftp> put d:\IBM.HXXXXXX.UXXXXXX

200 Port request OK.

125 Storing data set hlg.IBM.HXXXXXX.UXXXXXX
250 Transfer completed successfully

5744800 bytes sent in 0.28 seconds

ftp> quit
221 Quit command received. Goodbye.

3. Perform SMP/E RECEIVE and APPLY for the fix
4. If you used the @pathPrefix@ setting during the SMP/E installation, edit the

@confPath@/ccm/provision_profiles/rpp-profile.ini file and make sure that
the file URL points to the absolute path of the rpp-update-sites application.

Important: If you ran the BLZCPCCM installation job before the SMP/E
installation of the HXXXXXX FMID, you must copy the prefixpath/usr/1pp/
jazz/v4.0.3/server/conf/ccm/provision_profiles/rpp-profile.ini file to the
prefixpath/etc/jazz403/ccm/provision_profiles/ directory.

Edit the file and replace url=file:ccm/sites/rpp-update-site with

url=file:prefixpath/usr/1pp/jazz/v4.0.3/server/conf/ccm/sites/rpp-
update-site.
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Chapter 10. Uninstalling Rational Programming Patterns

The Rational Programming Patterns installation process does not automatically
uninstall the previous versions of the product.

About this task

The Uninstall option of IBM Installation Manager uninstalls packages that were
previously installed with IBM Installation Manager.

To uninstall packages on Windows, you must connect with the user account that
installed the product.

You can uninstall Rational Programming Patterns without uninstalling the other
products.

However, if you want to uninstall Rational Developer for System z or Rational
Developer for AIX and Linux, you must also uninstall Rational Team Concert and
Rational Programming Patterns.

Procedure
1. Close all the programs that you installed with Installation Manager.
2. From the start page of Installation Manager, click Uninstall.

3. On the Uninstall Packages page, select the packages that you want to uninstall.
Click Next.

4. On the Summary page, review the list of the packages that will be uninstalled
and then click Uninstall.

5. The Complete page is displayed after the uninstallation finishes.
6. Click Finish to exit.
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Chapter 11. Appendix: IBM Packaging Utility

You can use the IBM Packaging Utility software to copy packages to a repository
that can be placed on a web server available over HTTP or HTTPS. It is useful if
you have different offerings or service updates you want to place in a single
repository in addition to Rational Programming Patterns. You can use this
repository to perform interactive or silent installations.

You can use this utility to perform the following tasks:
* Generate a new repository for packages.

* Copy packages to a new repository. You can copy multiple packages into a
single repository; you then create a common location in your enterprise from
which products can be installed with IBM Installation Manager.

* Delete packages from a repository.

For detailed instructions on installing and using IBM Packaging Ultility, see the
Installation Manager information center, section Managing packages with|
[Packaging Utility]

To install the Rational Programming Patterns package from a repository on an
HTTP or HTTPS server, take the following steps:

1. Place the installation files in a temporary directory on your workstation.

2. Install the IBM Packaging Utility.

3. With the Packaging Utility, copy the Rational Programming Patterns package.
4

. Copy the output of the IBM Packaging Utility to an HTTP or HTTPS web
server.

5. Copy the installation files for IBM Installation Manager from product disk1 to a
shared drive.

6. Instruct users in your organization to install IBM Installation Manager.

7. Provide users the URL for the repository that contains the Rational
Programming Patterns package you created earlier.

Note: You can also use the repository to install silently. For more information
about silent installation, see [‘Installing silently” on page 8|
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Notices

© Copyright IBM Corporation 2010, 2013.

U.S. Government Users Restricted Rights - Use, duplication or disclosure restricted
by GSA ADP Schedule Contract with IBM Corp.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan, Ltd.

3-2-12, Roppongi, Minato-ku, Tokyo 106-8711 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
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Intellectual Property Dept. for Rational Software
IBM Corporation

20 Maguire Road

Lexington, Massachusetts 02421-3112

U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Trademarks and service marks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at fwww.ibm.com /legal /|
fcopytrades.html|

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other product and service names might be trademarks of IBM or other companies.
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